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What is Report? 

It is a piece of informative writing that describes a set of actions and analyses any results in
response to a specific brief. A quick definition might be: "This is what I did and this is what it
means.“

What is a good Report?

A good report is easy to be familiar with an issue raised as a subject because:

❖its title is precise and informative,

❖its layout and format are well organized, and

❖Its binding is easy to handle and opens flat to reveal both text and diagrams.
What is technical Report?
• The term “technical” refers to specific knowledge of specific area of study. This is to

mean “technical” refers knowledge which is not widespread or worldwide.
• Whenever you try to write or say anything about your field of specialization, you are

engaged in technical communications.
• Technical communication is the delivery of technical information to specific audiences.

The information should be of:
❖ their needs,
❖level of understanding and
❖background or experience.



• It is direct, informative, clear, and concise language written specifically for an
identified audience.

• The content must be accurate and complete with no exaggerations.
• To deliver the intended message, the text must be objective and persuasive

without being argumentative.
• It has a purpose/ objective. A technical document always is written for a reason,

and the purpose of reports may be to explain :
❖what was done,
❖why it was done, and/or
❖the results of a study.

• It conveys information/facts/data. A report without facts or scientific evidence to
support an opinion also usually lacks credibility, and it is likely to be
unsuccessful in achieving its purpose and objective.

• It might also include recommendations and conclusions of the research.  

➢The Purpose of Technical Report : To convey information as clearly and adequately as 
possible 



➢Scientific Papers purpose is to advance scientific knowledge by reporting original 
research, experiments, data, analysis, and conclusions.

➢Technical Papers purpose is to explain technology or engineering solutions, document
designs, describe processes, propose improvements, or summarize applied
research.

➢All scientific papers are technical in a broad sense, but not all technical papers are
scientific. Scientific papers focus on discovering new knowledge, whereas technical
papers focus on explaining or improving technology.

Aspect Scientific Paper Technical Paper

Goal Produce new scientific knowledge Explain/apply technology or engineering

Content Experiments, theories, data Methods, implementation, specifications

Audience Scientists, researchers Engineers, practitioners, technicians

Validation Strict peer review May be peer-reviewed, but not always

Focus Why phenomena occur How to use/implement technology



Technical Sentences Formation
1) Basic word order in English:
English has a strict order in which words can appear in a sentence. S1 shows an example of
this order.
➢S1. The researchers sent their manuscript to the journal.
This order is rarely altered. It is:
1. subject (the researchers)
2. verb (sent)
3. direct object (their manuscript)
4. indirect object (the journal)
❖ The key is to keep the subject, verb, direct object and indirect object as close to each
other as possible. This is illustrated in S2, which maintains the exact order of S1.
➢ S2. Last week the researchers sent their manuscript to the journal for the second

time.
➢ S3. The researchers last week sent for the second time to the journal their manuscript.
• S3 is incorrect English. The position of last week and for the second time is wrong, and the

indirect object comes before the direct object.



2) Choose the most relevant subject and put  it at the beginning of the sentence
The sentences below (S1–S4) come from a paper written by a physicist in a

physics journal. They all contain exactly the same information. However, there are four
possible subjects:
S1.  Particularly interesting for researchers in physics is the new feature, named X, for 

calculating velocity.
S2.  Physics now has a new feature, named X, for calculating velocity.
S3.  Velocity can now be calculated with a new feature, named X, which is particularly 

interesting for physicists.
S4.  X is a new feature for calculating velocity. It is particularly interesting for physicists.

When deciding what the subject is for your sentence, it is generally best to
choose the most recent or newest information. S1 and S2 refer to known situations -
physics, and physicists - they do not give any new information, so they are not well
constructed sentences. S3 also begins with a known, in this case velocity. This is fine if
velocity is the main focus. However, given that velocity is a common factor for
physicists, then S4 may be the best solution as it begins with completely new
information. The choice between S3 and S4 will depend on where the author wants to
put the focus.



3) Choose the subject that leads to the most concise sentence
If your sentence is short and you have two possible subjects, which you could 
indifferently put at the beginning of the sentence, then choose the subject that 
will give the shortest sentence (S2 rather than S1).
S1. The most significant values are highlighted in Table 1.
S2. Table 1 highlights the most significant values.

Shorter sentences are often obtained by using active (S2) rather than passive
(S1) verbs.
D) Don’t make the impersonal “it” the subject of the sentence
➢using modal verbs (can, must etc.)

original version (ov) revised version (rv)

It is necessary / mandatory to use X X must be used  (or) X is necessary / mandatory

It is advisable to clean the recipients. The recipients should be cleaned.

It is possible that inflation will rise. Inflation may rise.



4) Don’t use a pronoun (it, they) before you introduce  the noun (i.e. the 
subject of the sentence) that  the pronoun refers to

It is OK to use a pronoun at the beginning of the sentence, provided that 
this pronoun refers back to a noun in a previous sentence (i.e. a backward 
reference). For example:
S1. Beeswax is a very important substance because ... In fact, it is ...

In S1 it is clear that it refers to beeswax. But in S2 it refers to a noun that comes
after (i.e. a forward reference).

The reader does not know what the pronoun refers to and thus has to 
wait to find out.
S2.  *Although it is a very stable and chemically inert material, studies have 

verified that the 
composition of beeswax is …
S3.  Although beeswax is a very stable and chemically inert material, studies 

have verified that its composition is …
S3 immediately tells the reader what the subject is



5) Put the subject before the verb
➢The subject in English must come before their verb

➢Say what something is before you begin to describe it.

original version (ov) revised version (rv)

In the survey participated 350 subjects. Three hundred and fifty subjects participated 
in the survey

Were used several different methods in the 
experiments.

Several different methods were used in the experiments.

These values are associated with a series of 
measurements.

A series of measurements are associated with
these values.

original version (ov) revised version (rv)

Among the factors that influence the choice
of parameters are time and cost.

Time and cost are among the factors that
influence the choice of parameters.

Of particular interest was the sugar
transporter, because ..

The sugar transporter was of particular
interest, because ..

Important parameters are conciseness and
non-ambiguity.

Conciseness and non-ambiguity are important
parameters.



6) Avoid inserting parenthetical information between the subject and the verb
If you insert more than a couple of words between the subject and the verb this will interrupt 
the reader’s train of thought. In any case readers will consider this parenthetical information 
to be of less importance.

original version (ov) revised version (rv)

The result, after the calculation has been 
made, can be used to determine Y.

After the calculation has been made, the 
result can be used to determine Y.

This sampling method, when it is
possible, is useful because it allows ..

When this sampling method is possible, it
allows us .

These steps, owing to the difficulties in
measuring the weight, require some
simplifications.

Owing to the difficulties in measuring
the weight, these steps require some
simplifications.

or
These steps require some simplifications,
owing to the difficulties in measuring the
weight



7) Don’t separate the verb from its direct object
➢When a verb is followed by two possible objects, place the direct object (i.e. the thing given or received)

before the indirect object (the thing it is given to or received by). This kind of construction is often found with
verbs followed by ‘to’ and ‘with’

Ex-1: We can separate, with this tool, P and Q.

Correct one - We can separate P and Q with this tool.

Ex-2: We can associate a high cost, higher overheads, a significant increase in man-hours and several other
problems with these values.
Correct options are:

a) We can associate a high cost with these values, along with higher overheads, a significant increase in
man-hours and several other problems.

b)We can associate several factors with these values: a high cost, higher overheads, a significant increase in
man-hours and several other problems.

c)The following can be associated with these values:

i. a high cost

ii. higher overheads

iii. a significant increase in man hours



8) Put the direct object before the indirect object

9)Put adjectives before the noun they describe,  or use a relative clause
Ex: This is a paper particularly interesting for PhD students

Correct sentences: This is an interesting paper.

▪ If you want to put the adjective after the noun, you have to change the construction

• This paper is particularly interesting for PhD students.

• This is a paper that is particularly interesting for PhD students

original version (ov) revised version (rv)

However, only for some cases this 
operation is defined, these cases are 
called ...

However, this operation is only defined
for some cases, which are called ...

Although in the above references one 
can find algorithms for this kind of 
processing, the execution of …

Although algorithms for this kind of 
processing are reported in the above
references, the execution of…

This occurs when in the original 
network there is a dependent voltage

This occurs when there is a dependent
voltage in the original network.



10) Ensure there is no ambiguity in the order of the words

Ambiguity affects readability. If you force your reader to  constantly interpret what you are writing, 
the reader will soon want to stop reading.

Ex-1: I spoke to the professor with a microphone.

did I use the microphone or was the professor holding it?

Correct sentence:  I spoke to the professor who was holding a microphone

Ex-2: The European Union (EU) adopted various measures to combat these phenomena. This resulted in 
smog and pollution levels reduction.
When we read resulted in smog and pollution, our initial interpretation is that the smog and pollution are the 
result of the EU’s measures. Then when we move on and read levels we have to reprocess the information

Correct sentence: The European Union adopted various measures to combat this phenomena. This 
resulted in a reduction in smog and pollution levels.

Ex-3: We also demonstrated that x does not equal y as suggested by Walker (2011).

Are you saying that - Walker suggested that x is equal to y and is thus in contrast to what you are 
saying , or that he, like you, found that x does not equal y. 

• Unlike what was suggested by Walker (2011), we demonstrated that x does not equal y

• Our findings do not concur with Walker (2011). In fact, we demonstrated that x does not equal y.

(or) In agreement with Walker (2011), we demonstrated that x does not equal y



Transitions to join Sentences
Transition words are words or phrases that help establish connections between

sentences, paragraphs, or ideas in a piece of writing. They act as bridges, guiding readers
through the logical flow of information and signaling relationships between different parts of
the text. Furthermore, they provide coherence and cohesion to your writing by clarifying the
relationships between ideas, adding structure, and improving the overall readability.
• Role of Transition Words in Effective Academic Writing
➢Improving Readability and Comprehension: By facilitating smooth transitions and

organizing information effectively, these words enhance the readability and
comprehension of academic writing. They help readers navigate through complex texts,
understand complex ideas, and follow the structure of the argument. Transition words
facilitate reader navigation and comprehension, enhancing the reading experience with
increased engagement and accessibility.

➢Organizing Thoughts and Paragraphs: Transition words assist in organizing thoughts and
structuring the content of an academic paper. They provide a framework for presenting
ideas in a coherent and systematic manner. By indicating sequence, order, or Cause and
Effect relationships, these words help writers create a logical flow that guides readers
smoothly from one point to the next. They enable the construction of well-organized
paragraphs and facilitate the development of cohesive arguments.



➢Clarifying and Emphasizing: Transition words contribute to the clarity and
precision of academic writing. They help define terms, rephrase or restate ideas,
and provide necessary explanations. Additionally, they aid in emphasizing key
points and drawing attention to important information. By strategically utilizing
these words, writers can guarantee clear understanding of their ideas and effective
conveyance of the intended message to the reader.

➢Coherence and Cohesion: Transition words are instrumental in creating
coherence and cohesion within an academic paper. Coherence refers to the logical
and smooth progression of ideas, while cohesion refers to the interconnectedness
and unity of the text. They act as cohesive devices, linking sentences and
paragraphs together and establishing a cohesive flow of information. They
strengthen the logical connections between ideas, prevent abrupt shifts, and
enable readers to follow the writer’s argument effortlessly.

➢Connecting Ideas: Transition words bridge the gap between sentences,
paragraphs, and sections of an academic paper. They establish logical
connections, indicating how ideas are related and allowing readers to follow the
author’s train of thought. Whether showing addition, similarity, contrast, or
example, these words help readers navigate between concepts and comprehend
the overall message more effectively.





1. Addition
“Addition” transition words are used to introduce additional information or ideas that

support or supplement the main point being discussed. They serve to expand upon the topic,
provide further evidence, or present examples that strengthen your claims.
• Furthermore, the study not only analyzed the effects of X but also examined the impact of Y.
• Moreover, the results not only confirmed the initial hypothesis but also revealed additional

insights.
• Additionally, previous research has shown consistent findings, strengthening the validity of our

study.
2. Comparison and Contrast

“Comparison and Contrast” transition words are used in academic writing when you want to
highlight similarities, differences, or relationships between different concepts, ideas, or findings.
They help to establish clear connections and facilitate the comparison and contrast of various
elements within your research.
• Similarly, other researchers have reported comparable findings, corroborating the generalizability

of our results.
• In contrast, previous studies have demonstrated consistent patterns, reinforcing the existing body

of knowledge.
• In comparison, the current study offers a unique perspective by examining the relationship from a

different angle.



3. Cause and Effect
“Cause and Effect” transition words are used when you want to demonstrate the

relationship between a cause and its resulting effect or consequence. They help to clarify the cause-
and-effect relationship, allowing readers to understand the connections between different
variables, events, or phenomena.
• As a result, the data provides compelling evidence for a causal relationship between X and Y.
• Consequently, the hypothesis can be supported by the observed patterns in the collected data.
• Hence, the proposed model is validated, given the consistent and statistically significant results.

4. Example and Illustration
“Example and Illustration” transition words are used when you want to provide specific

instances, evidence, or illustrations to support and clarify your main points or arguments. These
words help to make your ideas more tangible and concrete by presenting real-life examples or
specific cases.
• For example, one study conducted by Jackson et al. (2018) demonstrated a similar phenomenon

in a different context.
• To illustrate this point, consider the case of Company X, which experienced similar challenges in

implementing the proposed strategy.
• In particular, the data highlights the importance of considering demographic factors, such as age

and gender, in the analysis.



5. Sequence and Chronology
“Sequence and Chronology” transition words are used in academic research papers when 

you want to indicate the order, progression, or sequence of events, ideas, or processes. These 
words help to organize information in a logical and coherent manner, ensuring that readers can 
follow the chronological flow of your research.
• First and foremost, the study aims to examine the long-term effects of intervention X on outcome 

Y.
• Subsequently, the participants were randomly assigned to either the control or experimental 

group.
• Finally, the data analysis revealed significant temporal trends that require further investigation.
6. Clarification and Restatement

“Clarification and Restatement” transition words are used in academic writing when you 
want to provide further explanation, clarify a point, or restate an idea in a different way. These words 
ensure that readers understand your arguments and ideas clearly, avoiding any ambiguity or 
confusion.
• In other words, the phenomenon can be explained by the interplay of various psychological and 

environmental factors.
• Specifically, the term “efficiency” refers to the ability to achieve maximum output with minimum 

resource utilization.
• To clarify, the concept of “sustainability” encompasses the ecological, economic, and social 

dimensions of development.



Common Mistakes to Avoid When Using Transition Words in Academic Writing
1. Overusing Transition Words: Using too many transition words can make your writing appear cluttered and
disrupt the flow of your ideas. Avoid overloading your sentences or paragraphs with excessive transitions.
Instead, use them strategically to enhance clarity and coherence.
2. Using Inappropriate or Irrelevant Transitions: Choose transition words that are appropriate for the context
and purpose of your writing. Avoid using them when they don’t align with the relationship between the ideas
you are connecting. Ensure that the transitions you use are relevant and contribute to the overall coherence of
your writing.
3. Neglecting Proofreading and Editing: As with any aspect of writing, proof reading and editing are crucial
when using transition words. Carefully review your writing to ensure that you use transitions correctly and
effectively. Look for any inconsistencies, redundancies, or errors in your use of transitions and make
necessary revisions.
4. Failing to Understand the Meaning: It’s important to understand the precise meaning and usage of
transition words before incorporating them into your writing. Using a transition word incorrectly or
inappropriately can lead to confusion or misinterpretation. Therefore, it is important to consult reliable
resources or style guides to familiarize yourself with the correct usage of each of these words.
5. Neglecting the Logical Flow: Transition words should help guide the reader through your writing and create
a logical flow of ideas. Failing to use appropriate transitions can result in a disjointed or fragmented
presentation. Ensure that your transitions establish clear connections and maintain the coherence of your
writing.
6. Relying Only on Transition Words: While transition words are valuable tools, they should not replace
effective writing and organization. Relying solely on transitions to connect your ideas can lead to weak or
poorly structured writing. Focus on developing strong topic sentences, clear paragraph organization, and
logical progression of ideas alongside the use of these words.
7. Ignoring Sentence Variety: Use transition words to enhance the variety and sophistication of your sentence
structures. Avoid using the same words repeatedly, as this can make your writing monotonous. Instead,
explore different transitions that convey the specific relationships between your ideas.



7. Emphasis

“Emphasis” transition words are used when you want to place special emphasis on certain
points, ideas, or findings. These words help to draw attention to key information, highlight the
significance of particular aspects, or underscore the importance of your arguments.

• Notably, this study addresses a significant gap in the existing literature.

• Importantly, the findings have implications for future policy decisions.

• In particular, the study examined the relationship between age and cognitive performance.

8. Summary and Conclusion

“Summary and Conclusion” transition words are employed in academic writing when you
want to provide a concise summary of the main points discussed in your paper and draw a
conclusion based on the findings or arguments presented. These help to signal the end of your
paper and provide closure to your research.

• In conclusion, the findings unequivocally support the initial hypothesis, emphasizing the
significance of the proposed theory.

• Overall, the results indicate a consistent pattern, providing a foundation for future research in this
area.

• In summary, this research makes a valuable contribution to the existing literature by extending
our understanding of the topic.



Tenses in writing
1. Present Simple Tense: Used to describe facts, general truths, and 
accepted scientific principles.
➢When to use:
• Scientific facts
• General statements
• Permanent truths
• Descriptions of figures/tables
➢Examples:
• Stress increases as the temperature rises.
• XRD provides information about crystal structure.
• Table 2 shows the mechanical properties.



2. Present Continuous Tense
➢Used rarely: only for ongoing actions happening at the moment of writing.
➢Examples:
• The team is currently analyzing the SEM images.
• Researchers are investigating new composite materials
3. Present Perfect Tense
➢Used to connect past research with its current relevance.
➢When to use:
• To refer to previous studies without mentioning specific time
• To show progress in the field
• To introduce background research
➢Examples:
• Many researchers have studied the creep behavior of alloys.
• Several methods have been proposed to improve XRD accuracy.



4. Past Simple Tense
➢Used to describe what you did in your own experiment or study.
➢When to use:
• Specific actions completed in the past
• Your methodology
• Your results
➢Examples:
• Samples were cut and polished using standard procedures.
• The thermal analysis showed a clear endothermic peak.
• We prepared the specimen according to ASTM standards.
5. Past Perfect Tense
➢Used when discussing two past events, one happening before the other.
➢Examples:
• The material had already fractured before the load was removed.
• We verified the calibration after we had assembled the equipment



6. Future Tense
➢Used for recommendations, future work, and expected outcomes.
➢Examples:
• Further studies will focus on optimizing the cooling rate.
• The next phase will include TEM analysis.

Purpose Best Tense Example

General facts Present Simple Creep increases with temperature.

Your experiment (methods) Past Simple We heated the specimen to 600°C.

Your experiment (results) Past Simple The fracture surface showed dimples.

Describing figures Present Simple Figure 4 illustrates the structure.

Previous studies Present Perfect Many authors have reported similar results.

Future work Future Further research will investigate…



Technical Report Planning and  Structuring
A technical report is a structured document that presents technical information,

research findings, or project results in a systematic manner. It is written to communicate clearly
with engineers, researchers, managers, or decision-makers.
• A technical report is used to convey important findings or test results to a controlled audience.
• Technical reports seldom undergo peer review.
• Distribution of a technical report is done at the discretion of the author or employee.
• The typical technical report is between two and twenty pages long in content and form.
• Technical documents require considerable thought and preparation.
➢The report follows a standardized format to ensure clarity, consistency, and ease of

reference. A typical technical report contains three major sections:
1. Preliminary Section (Front Matter)
2. Main Body
3. End Matter (Back Matter)



1. Preliminary Section (Front Matter)
• These are the elements that appear before the main text:
• Title Page

• Report title (clear and specific)
• Author’s name & designation
• Institution/organization name
• Date of submission
• Project/course details (if applicable)

• Acknowledgments(optional)
• Recognition of people, organizations, or funding agencies that supported the work.

• Abstract / Executive Summary
• A short summary (150–300 words) of the purpose, method, results, and conclusions.
• Helps readers quickly understand the report without reading the entire document.

• Table of Contents (ToC)
• List of chapters/sections with page numbers.

• List of Figures & Tables
• Optional, but useful in long reports for quick reference



2. Main Body
This is the core of the report, containing detailed information:
• Introduction

• Background of the topic or problem.
• Objectives and scope of the report.
• Importance or relevance of the study/project.

• Literature Review / Background Study(if applicable)
• Summary of previous work, theories, or standards related to the topic.
• Helps in establishing context.

• Methodology / Experimental Procedures
• Tools, techniques, and methods used.
• Detailed enough for others to replicate the work.
• Includes formulas, equipment, software, standards followed.

• Results / Findings
• Presentation of data collected.
• Use of charts, graphs, tables, and figures for clarity.
• Objective description without interpretation.



• Discussion / Analysis
• Interpretation of results.
• Comparison with expected outcomes or previous studies.
• Implications, strengths, and limitations of the work.

• Conclusion
• Summary of major findings.
• Whether objectives were achieved.
• Implications of the work.

• Recommendations(if required)
• Suggestions for improvements, further research, or actions to be taken

3. End Matter (Back Matter)
• References / Bibliography

• List of books, journal articles, websites, or standards cited in the report.
• Follow citation style (APA, IEEE, MLA, or institutional guidelines).

• Appendices
• Supplementary information not included in the main text.
• Example: raw data, detailed calculations, code snippets, maps, questionnaires.



How to Plan a Technical Report
1. Identify the Purpose
➢Before writing, decide:
• Why is the report being written?

→ To inform, explain, analyze, recommend, or evaluate?
• What problem or question does it address?
Example: “To present tensile test results and recommend suitable material for 
load-bearing applications.”
2. Know Your Target Audience
➢Ask:
• Who will read it? (engineers, managers, students, clients)
• What is their technical level?
• What do they expect to learn?
❖Why this matters: Audience decides your language, depth of explanation, 

visuals, and format.



3. Define the Scope
➢Be clear about:
• What is included in the report
• What is NOT included
❖This prevents unnecessary content.
4. Collect and Organize Information
➢Gather:
• Data (measurements, results, tables, graphs)
• Literature (journal references, background theory)
• Methods/procedures used
• Observations
➢Organize everything into:
• Facts
• Evidence
• Explanation



5. Prepare a Report Outline: A typical technical report outline according to a standard
6. Decide Writing Style and Tenses
➢Technical writing usually uses:
• Past tense for methods and results
• Present tense for facts
• Future tense for recommendation
7. Plan Visuals
➢Decide where to include:
• Graphs
• Tables
• Diagrams
• Charts
• Photographs
❖Visuals must support the explanation, not decorate.



8. Set Timeline
➢Plan:
• When to collect data
• When to draft sections
• When to revise
• When to proofread
❖A clear schedule avoids last-minute writing

9. Check Institutional/Company Guidelines
➢Follow required:
• Format
• Font
• Margin
• Citation style
• Length



10. Draft → Revise → Finalize
➢Write first draft
• Edit for clarity
• Check grammar and tense consistency
• Ensure logical flow
• Add final formatting
❖After writing the first draft, at least a dozen revision are usually needed to  improve to the 

text. Make sure that all authors read the first draft. Give them timeline...















Minutes of Meeting (MoM)
Minutes of Meeting are the official written record or the notes that capture of what

happened during a meeting. When approved, minutes of meetings are official and can be
used as evidence in legal proceedings.
➢Key Components of MoM
1. Meeting Details
• Date
• Time
• Venue
• Meeting Type (Project, Department, Review, etc.)
• Participants (Present/Absent)
2. Agenda Items
List of points to be discussed.
3. Discussion Summary
Short and clear description of what was discussed under each agenda item.
4. Decisions Made
What decisions were finalized



5. Action Items
• Task
• Person Responsible
• Deadline
6. Next Meeting Details
• Date
• Time
• Venue
7. Signature
Prepared by / Approved by

❖Despite the team, they are not a minute-by-minute record but include the key
details that the team will want to know.

❖They are an important source of information for people who were unable to attend
or looking back to reflect on what happened. They're also an incredibly effective
tool to notify or remind people of tasks assigned to them or timelines to keep
everyone on track

❖They also provide a reminder for future meetings and serve as an official reference







Signature of In charge



Drafts in Technical Writing
After you have collected your information, identified your document’s purposes, objectives, and

audience, developed an appropriate outline, and, if appropriate, sketched out key graphics and tables,
you are ready to begin writing the first draft of your document. Drafting is the stage of the writing process
in which you develop a complete first version of a piece of writing.
Draft helps to:
1. Organizing Thoughts and Structure
2. Improving Clarity and Accuracy
3. Identifying Gaps and Errors
4. Enhancing Readability
5. Peer Review and Feedback
6. Ensuring Compliance with Format and Standards
Tips for writing an effective rough draft
• Begin writing with the part you know the most about
• Do not worry at this stage about style, spelling or word processing. i.e. Don't aim for perfection; aim for 

completion
• Take short breaks to refresh your mind
• Use placeholders for tricky parts
• Write one section at a time and then reevaluate what to write next.
• Be reasonable with your goals.
• Keep your audience and purpose in mind as you write.



Revising your work: 
Ask yourself questions such as the following:
• Does the manuscript include all the information it should?
• Should any content be deleted?
• Is all the information accurate?
• Is all the reasoning sound?
• Is the content consistent throughout?
• Is everything logically organized?
• Is everything clearly worded?
• Have you stated your points briefly, simply, and directly? In other words,
• Is everything concise?
• Are grammar, spelling, punctuation, and word use correct throughout?
• Are all figures and tables well designed?
• Does the manuscript comply with the instructions?

Once your manuscript is nearly the best you can make it, show it to others and request
their feedback. After receiving feedback from those reviewing your manuscript, consider how to
apply it. Of course, follow those suggestions that you find useful. Even if a suggestion seems
unsuitable, keep it in mind. Revise your writing thoroughly but avoid the temptation to keep
revising it forever. No manuscript is perfect, so be satisfied with mere excellence.



Jargon Issues in Drafts
Jargon are special words or expressions used by a profession or group that are difficult for 

others to understand.
1. Overuse of Technical Jargon
• Early drafts sometimes contain too many technical terms, abbreviations, or discipline-specific 

language.
• This can make the report difficult to understand for non-specialist readers.
2. Unexplained Terminology
• Writers may assume readers know certain terms.
• Drafts often miss definitions, expansions of abbreviations, or explanations of concepts.
3. Inconsistency in Terms
• A term may be written differently in different sections (e.g., “SEM,” “S.E.M.,” “Scanning Electron 

Microscope”).
• Drafts help standardize terminology.
4. Misuse or Incorrect Use of Jargon
• Sometimes terms are used inaccurately or with unclear meaning.
• Drafting allows correction to maintain technical accuracy.
5. Unnecessary Complexity
• Using jargon where simple language would be clearer reduces readability.
• Drafts help replace unnecessary jargon with clear expressions.



Final Layout Issues in Drafts
Drafts also help identify and correct layout and formatting problems before the final 

version.
1. Paragraph and Section Alignment Problems
• Headings, subheadings, and paragraphs may not follow a uniform style.
• Drafts allow standardization using templates or formatting guidelines.
2. Poor Organization of Visual Elements
• Tables, figures, graphs may be misplaced, poorly labeled, or not referenced in the text.
• Draft revision ensures:

▪ proper numbering,
▪ captions,
▪ placement near relevant text.

3. Inconsistent Text Formatting
• Different fonts, sizes, spacing, or margins may appear in early drafts.
• Drafts help correct style inconsistencies.
4. Improper Page Breaks
• Sections may break awkwardly across pages.
• Draft review ensures smooth flow and clean pagination.



5. Incorrect Numbering
• Problems with:

▪ table numbering,
▪ figure numbering,
▪ equation numbering,
▪ section numbering.

• Drafts are essential for cross-checking and fixing these.
6. Lack of Uniform Layout Structure
• Title page, abstract, contents, references, and appendices may not follow required format 

(IEEE, APA, or institutional guidelines).
• Drafts ensure compliance with required layout standards.
7. Incomplete Headers/Footers
• Missing page numbers, report title, date, author details, etc.
• Drafts help finalize header and footer formatting.
8. Spacing and Alignment Issues
• Misaligned text, uneven spacing, inconsistent indentation, or irregular bullet points.
• Drafts are used to polish overall appearance.



Spelling in Technical Writing
Importance
• Correct spelling prevents misinterpretation of technical terms.
• Enhances credibility and professionalism of the document.
• Avoids confusion in scientific names, units, measurements, and technical 

terminology.
Common Issues
• Misspelling of scientific terms (e.g., “microscope” vs “micrscope”).
• Incorrect spelling of units (e.g., “metre” vs “meter” depending on standards).
• Mixing British and American spelling inconsistently (e.g., “colour” and “color”).
Best Practices
• Use technical dictionaries or glossaries.
• Enable spell-check tools.
• Maintain consistency in spelling style (UK or US).
• Double-check abbreviations and acronyms.



Punctuation in Technical Writing
Importance
• Punctuation helps in clarifying the meaning of a sentence.
• Avoids ambiguity in technical statements.
• Makes content readable and logically structured.
Common Mistakes
• Overuse/underuse of commas.
• Incorrect use of apostrophes in technical terms.
• Missing punctuation in long sentences.
• Incorrect punctuation in equations or units (e.g., “kg/s” not “kg s”).



➢Key Punctuation Elements
a. Full Stops
• Used to end complete statements.
• Important in separating independent ideas.
b. Commas
• Separate items in lists, clauses, or conditions.
• Prevent misreading of complex data-rich sentences.
c. Colons and Semicolons
• Colon (:) introduces lists, definitions, explanations.
• Semicolon (;) links closely related ideas or separates items containing commas.
d. Hyphens and Dashes
• Hyphens link compound words (e.g., “high-speed camera”).
• Dashes may indicate breaks or additional explanations.
e. Parentheses
• Used for additional information, equations, units, and references.



Grammar in Technical Writing
Importance
• Ensures clarity and precision.
• Avoids confusion, misinterpretation, or errors.
• Improves the logical flow of ideas.
❖Common Grammar Errors
• Subject-verb agreement

The results of the experiment shows significant improvement.
The results of the experiment show significant improvement.

• Run-on sentences
The theory was widely accepted it lacked empirical support.
The theory was widely accepted, but it lacked empirical support.

• Faulty sentence structure
Although the sample size was small. The results were valid.
Although the sample size was small, the results were valid.



• Incorrect tense usage.
Technical reports often use :
▪ Past tense for methods and results
▪ Present tense for established facts. 
▪ Future tense for recommendations

• Inconsistent use of active/passive voice.
Active voice for clarity & Passive voice for objectivity
Subject + Verb + Object :The engineer + designed + the circuit .
Object + (form of  )+ Past Participle + (by + Subject): The circuit +was+ designed +( by +the engineer) 

Active Voice Passive Voice

We tested the steel samples under tensile load. The steel samples were tested under tensile load.

The sensor detects the change in voltage. A change in voltage is detected by the sensor.

The software calculates the stress distribution. The stress distribution is calculated by the software

The team recorded the hardness values. The hardness values were recorded by the team



• Improper use of prepositions
The results were consistent to previous studies.
The results were consistent with previous studies.



• Confusing homophones
Their going to present there research in the next meeting.
They’re going to present their research in the next meeting.



• Redundant phrasing and wordiness
In the event that the experiment fails, we will repeat it again.
If the experiment fails, we will repeat it.

• Wrong word choice or form
The new policy had a positive affect on productivity.
The new policy had a positive effect on productivity.

• Using informal language or contractions
The study didn’t prove anything new.
The study did not provide any new findings.

• Unnecessary or missing apostrophe
Its a common issue in student writing.
It’s a common issue in student writing.

• Unnecessary or missing hyphen
The researcher conducted a long term study on corrosion.
The researcher conducted a long-term study on corrosion.



• Spelling and typos
The researchers recieved unexpected results.
The researchers received unexpected results.

• Faulty parallelism 
1. Parallelism Errors in Lists

The objectives of the experiment are to measure hardness, calculating tensile strength,
and the analysis of microstructure.”

“The objectives of the experiment are to measure hardness, to calculate tensile
strength, and to analyze the microstructure.”.
3. Parallelism Errors in Comparisons

The new alloy is stronger, lighter, and it lasts longer than the previous one.
The new alloy is stronger, lighter, and more durable than the previous one

4. Parallelism Errors in Technical Procedures
The sample was cut, polished, and then we etched it.
The sample was cut, polished, and etched.



5. Parallelism Errors in Tables/Figure Captions
Figure 4 shows measuring stress, recording strain, and how the sample fractured

Figure 4 shows stress measurement, strain recording, and fracture observation

6. Parallelism Errors in Bullet Points

7. Parallelism Errors in Headings/Subheadings

The experiment required the following 
steps:
• Preparing the sample
• The solution was heated
• To record the temperature

The experiment required the following steps:
• Preparing the sample
• Heating the solution
• Recording the temperature

➢ Forms are mixed → verb, sentence, 
infinitive (Wrong)

➢ All items start with -ing verbs → parallel  
(Correct)

1. Sample Preparation
2. Testing the Samples
3. Data Analysis
4. To Interpret the Results

1. Sample Preparation
2. Sample Testing
3. Data Analysis
4. Result Interpretation

➢ inconsistent structure(Wrong) ➢ all noun phrases (Correct)



• Grammar errors in lists, tables, and figure captions.
➢Lists
▪ Inconsistent Verb Forms

▪ Inconsistent Parts of Speech

▪ Missing Articles / Missing Plurals

The objectives of the experiment are:
• To measure hardness
• Calculating tensile strength
• Analysis of microstructure

The objectives of the experiment are:
• To measure hardness
• To calculate tensile strength
• To analyze microstructure

➢ Wrong ➢ Correct

The system can:
• Store data
• Real-time data processing
• Be efficient in analysis

The system can:
• Store data
• Process real-time data
• Analyze information efficiently

➢ Wrong ➢ Correct

The device includes:
• Sensor
• Battery
• Circuit

The device includes:
• A sensor
• A battery
• A circuit

➢ Wrong ➢ Correct



➢Tables
▪ Ambiguous Titles

Table 3: Results

Table 3: Mechanical Test Results for Mild Steel Samples

▪ Inconsistent Units / Labels

▪ Inconsistent Tense

Parameter Value(Wrong) Value(Correct)

Pressure 5 5 bar

Inlet Temperature 300°C 300°C

Outlet Temperature 300°F 100°C

Speed 1500 rpm 1500 rpm

Test Result (Wrong) Result(Correct)

Hardness Was high High

Tensile Strength High High

Impact Energy Shows good toughness High toughness



➢Figure Captions
▪ Missing Verb / Fragment

Figure 4: Stress vs. Strain curve for sample
Figure 4: Stress–strain curve for the tested sample

▪ Overly Long / Wordy Captions (Padding)
Figure 6: This figure shows the graph that illustrates the variation of hardness

values of the material samples which were heat treated at different temperatures
Figure 6: Hardness variation of heat-treated samples at different temperatures

▪ Inconsistent Capitalization
Figure 2: microstructure of the Sample after etching.
Figure 2: Microstructure of the sample after etching.

▪ Incorrect Prepositions
Figure 5: Crack formed on the welded joint.

Figure 5: Crack formed in the welded joint.



▪ Wrong or Missing Articles

Figure 3: SEM image of crack in sample

Figure 3: SEM image of the crack in the sample.
▪ Non-parallel phrasing

Figure 8: Measuring stress, strain measurement, and how the material fractured.
Figure 8: Stress measurement, strain measurement, and fracture observation.



Padding in Technical Writing
Padding is the use of unnecessary words, phrases, or repeated ideas that make the

writing longer without improving clarity. Technical writing values precision, so padding
reduces effectiveness.
➢Why Padding Happens
• Writers try to sound “formal.”
• They are unsure of the content and add filler.
• They try to lengthen the report.
• They use conversational (spoken) phrases.
Over-explaining obvious points also leads to padding
• Wrong:

“The experiment was carried out in the laboratory because that is where experiments are 
usually conducted.”

• Correct:
“The experiment was carried out in the laboratory.”



Wordy  (Padding) Phrases Concise Alternatives

At this moment in time Now / Currently

Due to the fact that Because

In the event that If

Has the ability to Can

A total of 10 samples 10 samples

It is important to note that the experiment was 
completed successfully. The experiment was completed successfully.

It can be clearly seen that the results improved. The results improved.

Due to the fact that the temperature increased… Because the temperature increased…

At this point in time, the system is stable. The system is currently stable

It is worth mentioning that no errors occurred. No errors occurred



Paragraph Issues in Technical Writing
Technical paragraphs must be organized, focused, and logically connected.
Common Paragraph Problems
A. Too Many Ideas in One Paragraph

Wrong: Cause of failure, corrective actions taken and results in a single paragraph
Correct: Paragraph 1: Cause of failure.

Paragraph 2: Corrective action and new results.
B. Missing Topic Sentence : A paragraph must begin with a clear purpose statement

Wrong: Data was collected from three machines. The values were different. The variation
increased with load

Correct: The performance variation of the machines was evaluated. From the data collected …
C. Paragraph Too Short (One-line Paragraphs): One-line paragraphs look incomplete.

Wrong: “The test failed.” (short, no explanation)
Correct: “The test failed because the sample fractured prematurely due to improper heat 

treatment.”
D. Paragraph Too Long: Long paragraphs hide key information.

Fix: Break into logical steps, subheadings, or bullet points.



Ambiguity Issues in Technical Writing
Ambiguity means the sentence can be understood in multiple ways. Technical 

writing must be unambiguous
A. Ambiguous Pronouns
• Ambiguous: “When the valve was placed near the pump, it failed.”

(What failed - the valve? or the pump?)
• Fix: “The valve failed when it was placed near the pump.”
B. Ambiguous Modifiers
• Bad: “We measured the pressure with the damaged gauge.”

(Was the gauge damaged? Or the pressure area?)
• Fix 1 (damaged gauge): “We used the damaged gauge to measure the pressure.”
• Fix 2 (damaged pressure area):“We measured the pressure in the damaged section.”
C. Ambiguous Statistics/Quantities
• Bad: “The temperature increased slightly.”

(How much?)
• Fix: “The temperature increased by 3°C.”



D. Ambiguous Timelines
• Bad: “The test will be completed soon.”
• Fix: “The test will be completed within two hours.”
E. Ambiguous Technical Words: Words like “high”, “sufficient”, “fast”, “heavy” are 
subjective.
• Bad: “The applied load was high.”
• Fix: “The applied load was 12kN
F. Ambiguous Comparisons
• Bad: “The new system is more efficient.”

(More efficient than what? Older model? Competitor?)
• Fix: “The new system is 15% more efficient than the previous model.”



• Tips To Avoid Ambiguity
1. Write Explicit Requirements: To be explicit means more than mentioning the

feature/technique/program you want to implement. You must be specific, detailed, and avoid
assuming that the reader knows what you mean. To make your point explicit and super clear, it
is a good idea to add examples.

2. Would and Should Must Be Avoided
Ex: The tank should be filled automatically (wrong)

3. Adverbs are great at causing ambiguity: Adverbs like generally, reasonably, usually,
normally, and so on are not specific and are open to interpretation.

4. Absolute Modifiers Add Clarity: Absolute modifiers are words like only, always, unique and so
on. They describe a quality that is either present in full or not present at all and that avoid
ambiguity

5. Write Using Consistent Terms: Consistently use terms, even if that may sound as repetition, to
not confuse the reader. Care should be also taken to see that they are not too repetitive.

6. Avoid Abbreviation Altogether: Abbreviations are a useful shortcut to make your writing
shorter and more comfortable for you. However, sometimes abbreviations may not be
adequately understood by your reader

7. Short Sentences and a Clear Layout: Using short sentences is a good practice for most kind of
writing. Short phrases that go straight to the point make texts very easy to read and, most
importantly, easier to understand. Proper use of list and bullet points helps a great deal in
adding clarity to your writing



Proofreading
Proofreading in a technical paper means carefully reviewing the final draft to

correct errors in grammar, spelling, punctuation, formatting, logic flow, and consistency
before submission or publication. It is the stage of verification, by the author him or herself,
or by another person. Thus, it is not only important to check grammar and spelling, it is also
highly advised to ensure that the idea of the writer/author that the article/work is clearly
written for its intended target audience and is communicated effectively. No author creates
an excellent text without reviewing, reflecting, and revising or trusting someone to do so
before the final version of their manuscript is complete and submitted.
➢Why Proofreading is Important in Technical Writing
Because technical reports must be:
• Precise → No ambiguity
• Accurate → No factual or numerical errors
• Professional → No language mistakes
• Easy to read → Clear, logical, well-organized

Errors reduce credibility and may cause misinterpretation of technical data, which 
can lead to faulty conclusions or unsafe engineering decisions.



Proofreading Checklist
• Grammar mistakes
• Spelling errors
• Punctuation issues
• Consistent units, symbols and terminologies
• Figure/Table captions
• Numbering consistency
• Ambiguous statements
• Matching the format with guidelines



Steps in effective Proofreading
1.Take a break after writing
A short break helps you view your writing with a fresh mind.
2. Make a list of errors that you commonly make and keep an eye out for them.
3. Use a printed version (if possible)
Errors often appear more clearly on paper.
4. Read aloud
Sometimes writing sounds different in your head than it sounds on paper.
5. Proofread more than once
➢Do separate passes (i.e., Proofread for only one type of error at a time) for:
• Grammar
• Formatting
• Figures/tables
• References
6. Read slowly and carefully.



Summaries
• A summary in technical writing is a short, precise restatement of the main ideas, key

findings, or essential information from a longer document. It removes all unnecessary
detail and presents only the core message, so that readers can understand the content
quickly and efficiently.

➢Types:
1. Executive Summary
• Purpose: To provide a brief overview of the entire (long) report, including its main points,

conclusions, and recommendations, for busy executives and decision-makers.
• Content: A condensed version of the report’s most important takeaways, often written to

stand alone and allow a reader to grasp the entire document's essence without reading it
in full.

2. Informative/ Abstract Summary
• Purpose: To present the essential information and findings of a report clearly and

concisely, enabling the reader to understand the core content. It is written in 150–250
words

• Content: Includes the key data, methods, and results, aiming to provide enough detail so
that a reader might not need to read the original document



3. Descriptive Summary
• Purpose: To provide a neutral, objective description of a document's content and purpose

without interpretation or judgment.
• Content: Outlines what the report is about, its structure, and its main topics, and does

not include results or conclusions, thus acting as a neutral overview.
4. Technical Summary
• Purpose: To summarize complex or technical information for a specific audience, such as

in scientific or engineering reports.
• Content: Focuses on the technical details, methods, findings, and implications of the

report.
➢A Conclusion appears at the end of a report and sums up the key ideas contained therein.

The conclusion reiterates key ideas discussed and draws inferences based on the
discussion or findings.

➢Briefing notes are often written by government workers to give the busy minister a
summary of important information needed for a meeting or for a decision



➢Steps in writing a summary
Step 1: Read the text
• You should read the article more than once to make sure you’ve thoroughly understood it. 

It’s often effective to read in three stages:
▪ Scan the article quickly to get a sense of its topic and overall shape.
▪ Read the article carefully, highlighting important points and taking notes as you read.
▪ Skim the article again to confirm you’ve understood the key points, and reread any

particularly important or difficult passages.
Step 2: Break the text down into sections
• To make the text more manageable and understand its sub-points, break it down into

smaller sections.
• If the text is a scientific paper that follows a standard empirical structure, it is probably

already organized into clearly marked sections, usually including an introduction,
methods, results and discussion.

• Other types of articles may not be explicitly divided into sections. But most articles and
essays will be structured around a series of sub-points or themes.



Step 3: Identify the key points in each section
• Now it’s time go through each section and pick out its most important points. What does

your reader need to know to understand the overall argument or conclusion of the article?
• Keep in mind that a summary does not involve paraphrasing every single paragraph of the

article. Your goal is to extract the essential points, leaving out anything that can be
considered background information or supplementary detail.

• In a scientific article, there are some easy questions you can ask to identify the key points
in each part.

Step 4: Write the summary
• To avoid plagiarism and to show that you’ve understood the article, it’s essential to

properly paraphrase the author’s ideas. Do not copy and paste parts of the article, not
even just a sentence or two. If you’re summarizing many articles as part of your own work,
it may be a good idea to use a plagiarism checker to double-check that your text is
completely original and properly cited. Just be sure to use one that’s safe and reliable.

❖Some points to be considered while writing the initial draft of the summary are:
▪ Write in your own words
▪ Start with a strong introduction
▪ Organize logically
▪ Keep it concise and unbiased



Step 5: Check the summary against the article
Finally, read through the article once more to ensure that:
• You’ve accurately represented the work
• You haven’t missed any essential information
• The phrasing is not too similar to any sentences in the original. Proofread and edit for

clarity, coherence, grammar, spelling, and punctuation errors. The final version should be
polished and professional. While proof reading see that the condensed/cut text does not
lead to misrepresenting the author’s ideas.

Step 6: Ensure it stands alone
Make sure the summary makes sense to someone who has not read the full report. It

should be a standalone document that conveys all the necessary information for decision-
making.



Presenting Final Reports
Presenting a final technical report is an essential skill in engineering, science, IT, and

business environments. It involves both written (printed) and oral (verbal) communication,
as well as understanding how to prepare proposals for future work. Presentation skills
generally focus on structuring of the matter, designing of slides, body language, and vocal
aspects.
➢Purpose of a Presentation
• Provide information or giving instructions: Providing information or giving instructions to

the audience is the most common purpose of a presentation. When a manager has to
inform about the efforts made by their team and outcomes there of then presentation is a
good option. Similarly, for passing on instructions to a group of people attending a training
program, presentations are being used. The goal here is that everyone listening to
presentation clearly understands and follows the instructions.

• Convince: Another situation when a presentation is adopted as a tool of communication
is for persuasion. The convincing purpose of presentation states that after attending the
presentation, listeners will agree to your proposal. A sales presentation falls under this
category where a salesperson tries to convince the potential buyers to place an order after
the completion of the presentation.

• Entertain: Entertainment purpose of a presentation is applicable in relatively more
informal situations like celebrating success, promotion parties, during induction or
retirement occasion. During these situations, humour is an essential part of the
presentation



➢Key Components of Presentation:
• A topic serving the purpose of the presentation
• A presenter
• An audience
• A venue or location
• Audio- visual aids
• Time limit

➢Pre- Presentation Preparations:
• Inspection of venue
• Get an audience profile
• Prepare the presentation
• Decide on audio- visual aids
• Deciding Presentation process
• Practicing



1. Printed Presentation
A printed presentation refers to the final written format of your technical report. It 

must be clear, professional, and easy to navigate. The printed report is what stakeholders 
read, refer to, archive, and use for decision-making.
A. Structure & Layout
• A printed report typically includes:
• Title page
• Abstract or Executive Summary
• Table of Contents
• Introduction
• Methodology
• Results
• Discussion
• Conclusions and Recommendations
• References
• Appendices



B. Formatting Guidelines
• Consistent font, margin, and spacing
• Numbered sections, figures, and tables
• Clear headings and subheadings
• Proper pagination
• Appropriate captions and labels
• Use of white space to avoid clutter
C. Visual Elements
• Graphs and charts must be easy to read
• Tables should be aligned and labelled
• Use colour only where necessary
• Maintain consistent formatting for all visuals
D. Language & Style
• Clear, concise, and objective
• Prefer active voice unless passive is required
• Avoid unnecessary jargon
• Ensure grammatical accuracy



2. Verbal Presentation Skills
Verbal presentation is the oral delivery of your final report. It is used in 

technical meetings, conferences, project reviews, viva voce, and client interactions.
A. Planning the Presentation
• Identify your audience
• Select the key findings
• Design clear PowerPoint slides
• Structure presentation:

▪ Introduction
▪ Problem statement
▪ Methodology
▪ Results
▪ Recommendations
▪ Conclusion



B. Effective Delivery Techniques
• Maintain eye contact
• Use a confident tone
• Control your pace (not too fast, not too slow)
• Avoid reading from slides or notes
• Engage with audience by asking/answering question
• The pitch should not be too high or too low
• Giving breaks during long presentations
• Give the audience a variety of content, and different methods of delivery - and activities too if

possible.
• Keep your audience attentive and enjoying themselves by

▪ Stories
▪ Questions and 'hands-up' feedback
▪ Inviting a volunteer to take the stage with you (should be carefully planned)
▪ Asking the audience to do something physical (clapping, blinking and other more inventive ideas)
▪ Fables and analogies
▪ Prizes, awards and recognizing people/achievements
▪ Etc..



C. Slide Design Principles
• 5–7 lines per slide
• Use bullet points
• Clear visuals
• Avoid overcrowding
• Use consistent templates
D. Handling Questions
• Listen completely
• Stay calm and factual
• Acknowledge limitations
• Provide examples when needed
E. Body Language
• Stand upright
• Use purposeful hand gestures
• Face the audience, not the screen
• Avoid nervous movements



Proposal
A proposal is a document written to persuade readers that what is proposed will

benefit them by solving a problem or fulfilling a need. When you write a proposal, therefore,
you must convince readers that they need what you are proposing, that it is practical and
appropriate, and that you are the right person/organization to provide the proposed
product/service.
Purpose of a Proposal
The main purposes of writing proposals are:

To identify a problem
• Proposals begin by clearly explaining the issue or need that must be addressed.

To present a solution or plan of action
• They outline how the problem can be solved through research, design, testing, or implementation.

To request resources
• A proposal may ask for funding, equipment, manpower, or approval from authorities.

To demonstrate feasibility
It must show that the proposed idea is realistic, practical, and technically achievable.

To persuade decision-makers
• Proposals act as a persuasive tool to convince supervisors, clients, or sponsors.



➢Qualities of a Good Proposal
A well-written proposal demonstrates:

Clarity
• Problem, plan, and benefits must be easy to understand.

Conciseness
• Avoid unnecessary details; focus on essential information.

Logical Structure
• Sections should follow a clear sequence.

Technical Accuracy
• Use correct data, methods, and terminology.

Feasibility
• Show that the plan can realistically be completed with available time and 

resources.
Persuasive Power

• Convince the audience through strong justification and evidence.
Professional Presentation

• Correct formatting, grammar, spacing, visuals, and referencing.



➢Proposal Types
• Internal Proposals: Internal proposals are written by and for someone within the same

organization. Since both the writer and reader share the same workplace context, these
proposals usually address some way to improve a work-related situation (productivity,
efficiency, profit, etc.).

• External Proposals: External proposals are sent outside of the writer’s organization to a
separate entity (often to solicit business, or to respond to another organization’s request for
proposals). Since these are external documents, they are usually formal in nature and may be
introduced by a letter of transmittal. These kind of proposals may be solicited or unsolicited.

• Solicited Proposals: You may write a solicited proposal if an organization identifies a
situation it wants to improve or a problem that it wants to solve. A department or an
organization may issue a request for proposals (RFP), asking for proposals on how to address
the situation or issue. The requesting department or organization will evaluate proposals and
choose the most convincing one, often using a detailed scoring rubric or weighted objectives
to determine which proposal best responds to the request and addresses the organization’s
needs.

• Unsolicited Proposals: You may initiate a proposal yourself if you see a problem or an
opportunity to make a beneficial change. With unsolicited proposals within an organization,
you need to identify your audience very carefully in order to get your ideas to the right
audience, either an individual or group with decision-making responsibility, or a supervisor
who can support the proposal and move it to a higher decision-making level. Always consider
your organization’s environment, internal politics, and how your proposal potentially may be
received. For unsolicited proposals outside of your organization, make sure that you clearly
create a need for your audience to convince that audience to read and respond. Unsolicited
external proposals are often the most difficult kind of proposal to get approved



❖Informal Proposals
An informal proposal is short, simple, and less structured. It is usually used within an

organization or between individuals where the request does not require extensive documentation.
➢Characteristics of Informal Proposals
• Usually 1–5 pages
• Simple structure, may be written as a memo, email, or short document
• Less strict formatting
• Direct and brief
• Used for routine requests or small projects
➢Common Uses
• Requesting additional equipment, Proposing a small repair or minor modification, Asking for

permission to attend a workshop, Recommending purchase of tools or software & Internal project
suggestions.

➢Typical Structure of an Informal Proposal
• Introduction / Purpose
• Problem or Need
• Proposed Solution
• Cost Estimate (if required)
• Benefits
• Conclusion / Request for Approval









❖Formal Proposals
A formal proposal is a detailed, well-structured document prepared for major 

projects, research funding, engineering designs, or external clients. It requires extensive 
planning, documentation, and strong justification.
➢Characteristics of Formal Proposals
▪ Can range from 10 pages to several hundred pages
▪ Follows a strict format and organization
▪ Includes detailed technical information
▪ Professional layout, visuals, tables, and references
▪ Used for major projects requiring large budgets or long timelines
Common Uses
▪ Government tenders, Engineering project proposals, Research funding applications, 

Business contracts and consultancy projects &Large construction or manufacturing 
projects



➢Typical Structure of a Formal Proposal
▪ Title Page
▪ Executive Summary
▪ Table of Contents
▪ Introduction / Background
▪ Problem Statement
▪ Objectives
▪ Scope of Work
▪ Methodology / Plan of Work
▪ Schedule / Timeline (Gantt chart)
▪ Budget and Resource Plan
▪ Expected Results / Deliverables
▪ Evaluation Criteria
▪ Qualifications of Team or Organization
▪ References / Appendices



Technical Proposal
Technical proposal writing requires transforming technical details into a persuasive,

proposal pitching your solution or offerings. It is a written official document proposed to carry
out some activity, with specified conditions on either side, with some financial considerations.
➢Proposal Writing General Practice
A. Understanding the audience
• Knowing who will read the proposal helps tailor the language and level of detail.
B. Breaking down complex ideas
• Strong proposals simplify technical content without losing accuracy.
C. Using data and evidence
• Supporting the proposal with research, diagrams, graphs, or case studies makes it more

credible.
D. Drafting and revising
• Good proposals go through multiple drafts to refine clarity, structure, and persuasion.
E. Following guidelines
• Many organizations have fixed proposal formats; writers must follow them exactly.
F. Proofreading
• Grammar, punctuation, and formatting errors reduce professionalism and weaken the

proposal.



➢Technical Proposal Structure
❖Prefatory sections: Include a title page, letter of transmittal, and an executive

summary to give a brief overview.

❖ Body of proposal: 

• Problem statement: Clearly define the problem or need and background/Introduction
about which the project will address.

• Proposed solution: Detail your technical solution, including specifications, how it
works, and what it will accomplish. It can also contain Objectives , Scope and
limitations.

• Methodology: Explain the approach and strategy you will use to complete the project.
This may include a project timeline, schedule and milestones.

• Management plan: Outline who will manage the project and the roles of the team
members. Highlight the qualifications and skills of the project team.

• Cost breakdown: Provide a transparent and detailed breakdown of the costs involved. If
necessary, provide the details of any cost, data and any other provisions needed to be
provided by the client.

❖Conclusion: Reiterate the strengths of your proposal and why your solution is the best
choice and should summarizes why the proposal should be accepted.



A Letter of Transmittal is a short, formal letter that accompanies a technical report or 
proposal when it is submitted to the reader (client, supervisor, or committee). It serves as a 
polite introduction to the main document.
➢A letter of transmittal introduces the report or proposal that follows:

• States why the document is being submitted.
• Identifies the title and purpose of the report.
• Mentions who requested it (if applicable).
• Highlights the scope, methods, or major findings briefly (optional).
• Expresses appreciation or willingness to provide clarification.
• Provides contact details (usually in formal reports).

❖It is placed before the title page in printed or formal technical reports.





Word Processor in Technical Writing
A modern word processor such as Microsoft Word provides powerful tools that help

writers prepare professional technical documents. These tools support organization,
revision, collaboration, navigation, citation, and document security. The following sections
explain the major features used in technical report preparation.
1. Adding a Table of Contents (TOC)



Adding process: References → Table of Contents → Automatic Table/Manual Table



➢Adding an Index
• Reference → Select the Word from one of the page →  Mark Entry



• Mark for indexing the word from single page only
• Mark all for indexing the word from all pages of the document
• Then select close

• Select the words required for indexing one by one



• Blank page → Reference → Insert Index → select 2 or 3 Columns → OK



• They appear as per the selection



➢Creating an outline: View → Outline
• Outlining helps structure a technical report before writing the full text.
• Effective planning and organization.
• Helps maintain logical flow in long documents



➢Adding Comments: Comments allow reviewers to provide feedback without altering the 
main text.

Review → Select text → New Comment → Type the comment→ Post



• One can edit the document  and reply to the comment

• Click on  the three dots and select the delete thread icon to delete all the comments



➢Tracking Changes: It shows all edits: insertions, deletions, formatting changes.
Review → Tracking → Tracking  Changes





➢Working with Footnotes and Endnotes
• Footnotes appear at the bottom of the page; endnotes appear at the end of the document.
• They are used for:  Citing sources, Adding explanations without interrupting main text & 

Providing technical references
• References → Insert Footnote / Insert Endnote.



➢Inserting Citations and Bibliography: Word contains a built-in referencing system.
• References → Insert Citation → Add New Source.
• Enter details (author, year, title, etc.).
• Insert a Bibliography or Works Cited page.
• Supported formats: APA, MLA, Chicago, IEEE, etc.



➢Comparing Documents: Used to compare two versions of a document.
• Word highlights differences in a new window.
• Checking revisions made by collaborators.
• Ensuring no content is lost.
• Review → Compare → Compare Documents.







➢Combining Documents: Merges multiple edited versions into a single file.
• Useful for team projects.
• Review → Compare → Combine.



➢Mark Document Final & Make Read-Only
• Disables typing and editing (can be reversed).
• Adds a "Marked as Final" notification.
• File → Info → Protect Document → Mark as Final
• Making a document fully read-only: Save As → Tools → General Options





➢Password Protect Word Documents
• To secure confidential technical reports.
• Enter a strong password and if the password is forgotten, the document cannot be 

recovered

• File → Info → Protect Document → Encrypt with Password.





➢Using Macros
• A macro automates repetitive tasks by recording a sequence of actions.
• View → Macros → Record Macro.
• Perform actions to be automated.
• Click Stop Recording.
• Run macro when needed.
▪ Examples:
• Formatting large documents
• Inserting repeated tables or symbols
• Automating calculations





Intellectual Property
Intellectual property rights are the legal rights that cover the privileges given to

individuals who are the owners and inventors of a work, and have created something with
their intellectual creativity. Individuals related to areas such as literature, music, invention,
etc., can be granted such rights, which can then be used in the business practices by them.
The creator/inventor gets exclusive rights against any misuse or use of work without his/her
prior information. However, the rights are granted for a limited period of time to maintain
equilibrium.
➢Legislations covering IPRs in India:
Patents: The Patents Act, 1970 as amended in 1999, 2002 and 2005
Design: The Designs Act, 2000
Trade Mark: The Trade Marks Act, 1999
Copyright: The Copyright Act, 1957 as amended in 1983, 1984 and 1992, 1994, 1999
Layout Design of Integrated Circuits: The Semiconductor Integrated Circuits Layout
Design Act, 2000
Protection of Undisclosed Information: No exclusive legislation exists but the matter
would be generally covered under the Contract Act, 1872
Geographical Indications: The Geographical Indications of Goods (Registration and
Protection) Act, 1999
Plant Varieties: The Protection of Plant Variety and Farmers’ Rights Act, 2001



➢Patents
• A patent is a legal right granted for an invention that is new, useful, and non-obvious. The

invention may be a product, process, machine, chemical composition, or technological
improvement.

Nature and Features of Patents
• Provides exclusive rights to the inventor for 20 years (from filing date).
• Others cannot make, use, sell, or import the invention without permission.
• Encourages innovation by providing commercial benefits.
• Requires public disclosure of the invention after the grant.
Examples
• A new drug molecule
• A novel electricity-saving device
• Improved manufacturing process



➢Industrial Designs
• Industrial Design (Design Rights) protect the aesthetic or ornamental aspects of a 

product.
Key Characteristics
• Protects shape, pattern, configuration, or visual appearance.
• Does not protect the function of the product (only looks).
• Valid for 10 years (extendable in many countries).
Examples
• Design of a mobile phone body
• Shape of a furniture piece
• Pattern on textiles



➢Trademarks
• A trademark is a sign, symbol, word, or logo that distinguishes goods or services of one 

company from another.
Nature of Trademarks
• Builds brand identity and customer trust.
• Protects logos, brand names, slogans, sound marks, etc.
• Renewable every 10 years, so protection can last indefinitely.
Examples
• Nike “✓” logo
• Coca-Cola wordmark
• Intel chime sound logo



➢Copyright
• Copyright protects original literary, artistic, dramatic, musical, and software works.
Nature of Copyright
• Covers the expression of ideas, not the idea itself.
• Protection lasts for the lifetime of the author + 60 years (varies by country).
• Automatically granted when the work is created.
Examples
• Books, articles, software code
• Movies, songs, paintings
• Photographs, architectural designs



Process of Patenting and Development
Innovation to commercialization involves several stages. The typical process

includes technological research, innovation, patenting, and development.
1. Technological Research
This is the foundation for creating new inventions.
Activities involved
• Literature review
• Identifying problems and research gaps
• Experimental work, prototyping, simulations
• Collecting data and validating results
❖Research provides the scientific or technical foundation required for innovation.



2. Innovation
• Innovation converts research outcomes into a practical, useful invention.
• Characteristics
• Must solve a real-world problem
• Should have technical advancement
• Adds commercial or societal value
• Leads to a patentable invention
❖Innovation transforms theory into application

3. Patenting Process
The patenting procedure involves:
a. Patentability Check
• Determine whether the invention is:

▪ Novel
▪ Non-obvious
▪ Industrial applicable

b. Prior-Art Search
• Search existing patents and publications to confirm originality.



c. Drafting the Patent Application
Includes:
• Title
• Field of invention
• Background
• Description
• Claims (most important)
• Drawings (if required)
d. Filing the Patent
Types:
• Provisional Application
• Complete Specification







e. Examination

• Patent office evaluates the invention for novelty and usefulness.
f. Grant
• If all conditions are satisfied, patent is granted for 20 years.
g. Maintenance
• Periodic fees are required to keep the patent active.



Publication of a Patent
• A patent application will be published in the Official Journal of the Patent Office on expiry

of eighteen months from the date of filing or date of priority of the application, whichever
is earlier. It can also be published earlier, if such a request is made by the applicant.

• An application will not be published in cases where directions have been given for
secrecy, until the term of those directions expires. If an applicant wishes to withdraw the
application on his own without any secrecy consideration, he can do so by withdrawing his
application at-least three months before the date of the publication. In that case the
application will not be published.

• The publication of every application includes the particulars of the date of application,
application number, name and address of the applicant, an abstract, and is open for
public inspection. However, the whole patent document can be obtained from the Patent
Office upon payment of the requisite fees. These documents are now also available online
at the Patent Office website www.ipindia.nic.in. The Official Journal of the Patent Office
and the patent database in the searchable form can be accessed through this website.



• Each country is free to grant or refuse a patent on the basis of scrutiny by its
patent office. This means that grant of a patent in one country does not
guarantee that some other country will also grant patent for the same
invention. Similarly, the refusal of the patent in one country does not mean
that it will be refused in other countries.

• There is nothing like a global patent or a world patent. Patent rights are
essentially territorial in nature and are protected only in a country (or
countries), which has (have) granted these rights. Therefore, the patent could
only be enforced in such countries. In other words, for obtaining patent rights
in different countries one has to submit patent applications in all the
countries of interest for grant of patents. This would entail payment of official
fees and associated expenses, like the attorney fees, essential for obtaining
patent rights in each country. However, there are some regional systems
where by filing one application, one could simultaneously obtain patents in
the member countries of a regional system; European Patent Office is an
example of a similar system.



➢Opposition under the Indian Patents Act 1970
The Act now provides for pre-grant and post-grant opposition. Pre-grant opposition

can be filed after the publication of patent application and before the grant of patent. Post-
grant opposition can be filed within one year of the grant of the patent. An opposition board
will be constituted for each of the opposition notifications accepted by the Controller for the
post grant opposition proceedings. Opposition in both cases will be allowed on all grounds
specified in the Act.
Pre-grant and post-grant opposition can be filed only on the following grounds:-
i. Claimed invention or its part wrongfully obtained;
ii. Claimed invention is published in a patent or any other document before the priority date;
iii. Claimed invention is published in a patent after the priority date having earlier priority
date;
iv. Claimed invention was publicly known or publicly used before the priority date;
v. Claimed invention is obvious and does not involve clearly any inventive step, as regards to
the matter published or used (in India) before the priority date;



vi. Claimed invention is not an invention within the meaning of the Patents Act or is not
patentable under the Patents Act;
vii. The complete specification does not sufficiently and clearly describe the invention or
the method by which it is to be performed;
viii. The applicant has failed to disclose to the Controller the information regarding foreign
applications filed by him for the same invention or has furnished the information which in
any material particular was false to his knowledge;
ix. In case of convention application if the application is not filed before the expiry of 12
months from the date of first application in convention country;
x. The complete specification does not disclose or wrongly mentions the source and
geographical origin of biological material used in the invention;
xi. Claimed invention was anticipated having regard to the knowledge, oral or
otherwise available within any local or indigenous community in India or elsewhere.



4. Development and Commercialization
• Once patented, the invention can be:
• Manufactured and sold commercially
• Licensed to companies
• Assigned (sold) to another party for royalties
• Used as a basis for startups
❖This phase converts intellectual property into economic value.



International Scenario: International Cooperation on Intellectual Property
As technology and trade become global, countries cooperate through international 

agreements to protect IP across borders.
1. WIPO – World Intellectual Property Organization
➢A United Nations agency that promotes worldwide IP protection.
Functions
• Administers international treaties
• Provides global databases for patents and trademarks
• Encourages IP development and harmonization
2. TRIPS Agreement (WTO)
➢Trade-Related Aspects of Intellectual Property Rights (TRIPS) sets minimum IP standards 

for all WTO members.
Key Features
• Standardizes patent protection for 20 years
• Protects trademarks, copyrights, geographical indications
• Ensures enforcement mechanisms



3. PCT – Patent Cooperation Treaty
➢Allows inventors to file one international patent application that is recognized in over

155 countries.
Benefits
• Simplifies global patent filing
• Provides international search reports
• Delays national-phase expenses
4. Madrid System (Trademarks)
➢Provides a centralized system for registering trademarks in multiple countries through a 

single application.
5. Hague System (Designs)
➢Allows international registration of industrial designs through one application



6. Cooperation in Enforcement
Countries share:
• Anti-piracy measures
• Anti-counterfeiting actions
• Border enforcement rules
• Collaborative IP training programs

The Patent Cooperation Treaty (PCT) is a multilateral treaty entered into force in 1978.
Through PCT, an inventor of a member country (Contracting State) of PCT can
simultaneously obtain priority for his/her invention in all the member countries, without
having to file a separate application in those countries, by filing of PCT application, which is
popularly known as International Application. India joined the PCT on December 7, 1998.

Intellectual Property Rights are essential for protecting creativity, encouraging
innovation, and supporting economic development. Patents, designs, trademarks, and
copyright each protect different aspects of intellectual creation. The process of patenting
involves research, innovation, filing, examination, and commercialization. Globally, systems
such as WIPO, TRIPS, PCT, Madrid, and Hague ensure international cooperation and
uniform protection standards. Together, these frameworks help maintain innovation and
competitive growth in a globalized world.
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